
Photoshop FILTER Guide 

FILTER GALLERY  -- The Filter Gallery lets you apply filters cumulatively and apply individual filters more than once. You can view thumbnail examples of 
what each filter does. You can also rearrange filters and change the settings of each filter you’ve applied to achieve the effect you want. Because it is so flexible, 
the Filter Gallery is often the best choice for applying filters. However, not all filters listed in the Filters menu are available in the Filter Gallery.  To display the Filter 
Gallery, choose Filter > Filter Gallery. Clicking a filter category name displays thumbnails of available filter effects. 

 

A. Preview  B. Filter category  C. Thumbnail of selected filter  D. Show/Hide filter thumbnails  E. Filters pop�up menu  F. Options for selected filter  G. List of filter 
effects to apply or arrange  H. Filter effect selected but not applied  I. Filter effects applied cumulatively but not selected  J. Hidden filter effect 

ARTISTIC – used to achieve a painterly or special effect for a fine arts or commercial project. For example, use the Cutout filter for collages or type 
treatment. These filters replicate natural or traditional media effects. 

Colored Pencil Draws an image using colored pencils on a solid background. Important edges are retained and given a rough crosshatch appearance; the solid 
background color shows through the smoother areas. 

For a parchment effect, change the background color just before applying the Colored Pencil filter to a selected area. 

Cutout Portrays an image as though it were made from roughly cut-out pieces of colored paper. High-contrast images appear as if in silhouette, while colored 
images are built up from several layers of colored paper. 

Dry Brush Paints the edges of the image using a dry brush technique (between oil and watercolor). The filter simplifies an image by reducing its range of colors to 
areas of common color. 

Film Grain Applies an even pattern to the shadow tones and midtones of an image. A smoother, more saturated pattern is added to the image's lighter areas. This 
filter is useful for eliminating banding in blends and visually unifying elements from various sources. 

Fresco Paints an image in a coarse style using short, rounded, and hastily applied dabs. 
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Neon Glow Adds various types of glows to the objects in an image and is useful for colorizing an image while softening its look. To select a glow color, click the 
glow box and select a color from the color picker. 

Paint Daubs Lets you choose from various brush sizes (from 1 to 50) and types for a painterly effect. Brush types include simple, light rough, light dark, wide sharp, 
wide blurry, and sparkle. 

Palette Knife Reduces detail in an image to give the effect of a thinly painted canvas that reveals the texture underneath. 

Plastic Wrap Coats the image in shiny plastic, accentuating the surface detail. 

Poster Edges Reduces the number of colors in an image (posterizes) according to the posterization option you set, and finds the edges of the image and draws 
black lines on them. Large broad areas of the image have simple shading, while fine dark detail is distributed throughout the image. 

Rough Pastels Makes an image appear as if stroked with colored pastel chalk on a textured background. In areas of bright color, the chalk appears thick with little 
texture; in darker areas, the chalk appears scraped off to reveal the texture. For more on the filter options. 

Smudge Stick Softens an image using short diagonal strokes to smudge or smear the darker areas of the images. Lighter areas become brighter and lose detail. 

Sponge Creates images with highly textured areas of contrasting color, appearing to have been painted with a sponge. 

Underpainting Paints the image on a textured background, and then paints the final image over it. For more on the filter options. 

Watercolor Paints the image in a watercolor style, simplifying details in an image, using a medium brush loaded with water and color. Where significant tonal 
changes occur at edges, the filter saturates the color. 

BLUR – used to soften a selection or an image, and are useful for retouching. They smooth transitions by averaging the pixels next to the hard edges of 
defined lines and shaded areas in an image. 
 
Average Finds the average color of an image or selection, and then fills the image or selection with the color to create a smooth look. For example, if you select 
an area of grass, the filter will change the area into a smooth patch of green. 

Blur and Blur More Eliminate noise where significant color transitions occur in an image. Blur filters smooth transitions by averaging the pixels next to the hard 
edges of defined lines and shaded areas. The Blur More filter produces an effect three or four times stronger than that of the Blur filter. 

Gaussian Blur Quickly blurs a selection by an adjustable amount. Gaussian refers to the bell-shaped curve that is generated when Adobe Photo-shop applies a 
weighted average to the pixels. The Gaussian Blur filter adds low-frequency detail and can produce a hazy effect. 

Lens Blur Adds blur to an image to give the effect of a narrower depth of field so that some objects in the image stay in focus while others areas become blurred. 
A simple selection can be used to determine which areas become blurred, or you can provide a separate alpha channel depth map to describe exactly how you 
want the blur added. 

Motion Blur Blurs in a particular direction (from -360º to +360º) and at a specific intensity (from 1 to 999). The filter's effect is analogous to taking a picture of a 
moving object with a fixed exposure time. 

Radial Blur Simulates the blur of a zooming or rotating camera to produce a soft blur. Choose Spin, to blur along concentric circular lines, and then specify a 
degree of rotation; or Zoom, to blur along radial lines, as if zooming in or out of the image, and specify an amount from 1 to 100. Blur quality ranges from Draft 
for the fastest but grainy results; or Good and Best for smoother results, which are indistinguishable except on a large selection. Specify the origin of the blur by 
dragging the pattern in the Blur Center box. 

Shape Blur Simulates the blur of a zooming or rotating camera to produce a soft blur. Choose Spin to blur along concentric circular lines, and then specify a 
degree of rotation. Choose Zoom to blur along radial lines, as if zooming into or out of the image, and specify a value from 1 to 100. Blur quality ranges from 
Draft (for fast but grainy results) or Good and Best for smoother results, which are indistinguishable from each other except on a large selection. Specify the origin 
of the blur by dragging the pattern in the Blur Center box. 

Smart Blur Precisely blurs an image. You can specify a radius, to determine how far the filter searches for dissimilar pixels to blur; a threshold, to determine how 
different the pixels' values should be before they are eliminated; and a blur quality. You also can set a mode for the entire selection (Normal), or for the edges of 
color transitions (Edge Only and Overlay). Where significant contrast occurs, Edge Only applies black-and-white edges, and Overlay Edge applies white. 
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Surface Blurs an image while preserving edges. This filter is useful for creating special effects and for removing noise or graininess. The Radius option specifies the 
size of the area sampled for the blur. The Threshold option controls how much the tonal values of neighboring pixels must diverge from the center pixel value 
before being part of the blur. Pixels with tonal value differences less than the Threshold value are excluded from the blur. 

BRUSH STROKES – Like the Artistic filters, the Brush Stroke filters give a painterly or fine-arts look using different brush and ink stroke effects. Some of the 
filters add grain, paint, noise, edge detail, or texture to an image for a pointillist effect.  

Accented Edges Accentuates the edges of an image. When the edge brightness control is set to a high value, the accents resemble white chalk; when set to a low 
value, the accents resemble black ink. 

Angled Strokes Repaints an image using diagonal strokes. The lighter areas of the image are painted in strokes going in one direction, while the darker areas are 
painted in strokes going the opposite direction. 

Crosshatch Preserves the details and features of the original image while adding texture and roughening the edges of the colored areas in the image with 
simulated pencil hatching. The Strength option controls the number of hatching passes, from 1 to 3. 

Dark Strokes Paints dark areas of an image closer to black with short, tight strokes, and paints lighter areas of the image with long, white strokes. 

Ink Outlines Redraws an image with fine narrow lines over the original details, in pen-and-ink style. 

Spatter Replicates the effect of a spatter airbrush. Increasing the options simplifies the overall effect. 

Sprayed Strokes Repaints an image, using its dominant colors with angled, sprayed strokes of color. 

Sumi-e Paints an image in Japanese style, as if with a wet brush full of black ink on rice paper. The effect is soft blurry edges with rich blacks. 

DISTORT – used to geometrically distort an image, creating 3D or other reshaping effects. Note that these filters can be very memory intensive. 
 

Diffuse Glow Renders an image as though it were viewed through a soft diffusion filter. The filter adds see-through white noise to an image, with the glow fading 
from the center of a selection. 

Displace filter Uses an image, called a displacement map, to determine how to distort a selection. For example, using a parabola-shaped displacement map, you 
can create an image that appears to be printed on a cloth held at its corners. 

This filter creates displacement maps, using a flattened file saved in Adobe Photoshop format (except Bitmap mode images). You can also use the files in the Plug-
Ins/ Displacement Maps folder in the Photoshop program folder.  

The Displace filter shifts a selection using a color value from the displacement map--0 is the maximum negative shift, 255 the maximum positive shift, and a gray 
value of 128 produces no displacement. If a map has one channel, the image shifts along a diagonal defined by the horizontal and vertical scale ratios. If the 
map has more than one channel, the first channel controls the horizontal displacement and the second channel controls the vertical displacement. 

Glass Makes an image appear as if it is being viewed through different types of glass.You can choose a glass effect or create your own glass surface as a 
Photoshop file and apply it. You can adjust scaling, distortion, and smoothness settings. When using surface controls with a file, follow the instructions for the 
Displace filter. For more information about Glass filter controls. 

Lens Correction The Lens Correction filter fixes common lens flaws such as barrel and pincushion distortion, vignetting, and chromatic aberration. 

Ocean Ripple Adds randomly spaced ripples to the image's surface, making the image look as if it were under water. 

Pinch Squeezes a selection. A positive value up to 100% shifts a selection toward its center; a negative value up to -100% shifts a selection outward. 

Polar Coordinates Converts a selection from its rectangular to polar coordinates, and vice versa, according to a selected option. You can use this filter to create a 
cylinder anamorphosis--art popular in the 18th century--in which the distorted image appears normal when viewed in a mirrored cylinder. 

Ripple Creates an undulating pattern on a selection, like ripples on the surface of a pond. For greater control, use the Wave filter. Options include the amount 
and size of ripples. 
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Shear Distorts an image along a curve. Specify the curve by dragging the line in the box to form a curve for the distortion. You can adjust any point along the 
curve. Click Default to return the curve to a straight line. In addition, you choose how to treat undistorted areas. 

Spherize Gives objects a 3D effect by wrapping a selection around a spherical shape, distorting the image and stretching it to fit the selected curve. 

Twirl Rotates a selection more sharply in the center than at the edges. Specifying an angle produces a twirl pattern. 

Wave Works in a similar way to the Ripple filter, but with greater control. Options include the number of wave generators, the wavelength (distance from one 
wave crest to the next), the height of the wave, and the wave type: Sine (rolling), Triangle, or Square. The Randomize option applies random values. You can also 
define undistorted areas. 

To replicate wave results on other selections, click Randomize, set the Number of Generators to 1, and set the minimum and maximum Wavelength and 
Amplitude parameters to the same value. 

ZigZag Distorts a selection radially, depending on the radius of the pixels in your selection. The Ridges option sets the number of direction reversals of the zigzag 
from the center of the selection to its edge. You also choose how to displace the pixels: Pond Ripples displaces pixels to the upper left or lower right, Out From 
Center displaces pixels toward or away from the center of the selection, and Around Center rotates pixels around the center. 

NOISE – used to add or remove noise, or pixels with randomly distributed color levels. This helps to blend a selection into the surrounding pixels. Noise filters 
can create unusual textures or remove problem areas, such as dust and scratches, from an image. 

Add Noise Applies random pixels to an image, simulating the effect of shooting pictures on high-speed film. The Add Noise filter can also be used to reduce 
banding in feathered selections or graduated fills or to give a more realistic look to heavily retouched areas. Options include noise distribution: Uniform 
distributes color values of noise using random numbers between 0 and plus or minus the specified value for a subtle effect; Gaussian distributes color values of 
noise along a bell-shaped curve for a speckled effect. The Monochromatic option applies the filter to only the tonal elements in the image without changing the 
colors. 

Despeckle Detects the edges in an image (areas where significant color changes occur) and blurs all of the selection except those edges. This blur-ring removes 
noise while preserving detail. 

Dust & Scratches Reduces noise by changing dissimilar pixels. To achieve a balance between sharpening the image and hiding defects, try various combinations 
of radius and threshold settings. Or apply the filter on selected areas in the image. 

Median Reduces noise in an image by blending the brightness of pixels within a selection. The filter searches the radius of a pixel selection for pixels of similar 
brightness, discarding pixels that differ too much from adjacent pixels, and replaces the center pixel with the median brightness value of the searched pixels. This 
filter is useful for eliminating or reducing the effect of motion on an image. 

Reduce Noise Reduces noise while preserving edges based on user settings affecting the overall image or individual channels. 

PIXELATE – used to sharply define a selection by clumping pixels of similar color values in cells. 

Color Halftone Simulates the effect of using an enlarged halftone screen on each channel of the image. For each channel, the filter divides the image into 
rectangles and replaces each rectangle with a circle. The circle size is proportional to the brightness of the rectangle.  

Crystallize Clumps pixels into a solid color in a polygon shape. 

Facet Clumps pixels of solid or similar colors into blocks of like-colored pixels. You can use this filter to make a scanned image look hand painted or to make a 
realistic image resemble an abstract painting. 

Fragment Creates four copies of the pixels in the selection, averages them, and offsets them from each other. 

Mezzotint Converts an image to a random pattern of black-and-white areas or of fully saturated colors in a color image. To use the filter, choose a dot pattern 
from the Type menu in the Mezzotint dialog box. 

Mosaic Clumps pixels into square blocks. The pixels in a given block are the same color, and the colors of the blocks represent the colors in the selection. 
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Pointillize Breaks up the color in an image into randomly placed dots, as in a pointillist painting, and uses the background color as a canvas area between the 
dots. 

RENDER – used to create 3D shapes, cloud patterns, refraction patterns, and simulated light reflections in an image. You can also manipulate objects in 3D 
space, and create texture fills from grayscale files to produce 3D-like effects for lighting. 

Clouds Generates a soft cloud pattern using random values that vary between the foreground and the background colors. To generate a more stark cloud 
pattern, hold down Alt (Windows) or Option (Mac OS) as you choose Filter> Render > Clouds. 

Difference Clouds Uses randomly generated values that vary between the foreground and back-ground color to produce a cloud pattern. The filter blends the 
cloud data with the existing pixels in the same way that the Difference mode blends colors. The first time you choose this filter, portions of the image are inverted 
in a cloud pattern. Applying the filter several times creates rib and vein patterns that resemble a marble texture. 

Fibers Creates the look of woven fibers using the foreground and background colors. You can control how the colors vary by sliding the Variance slider (a low 
value creates longer streaks of color, while a high value makes very short fibers with more varied distribution of color). The Strength slider controls how each fiber 
looks. A low setting creates spread out fibers, while a high setting produces short, stringy fibers. Click the Randomize button to change how the pattern looks; you 
can click the button a number of times until you find a pattern you like. When you apply the Fibers filter, the image data on the active layer is replaced with fibers. 

Lens Flare Simulates the refraction caused by shining a bright light into the camera lens. Specify a location for the center of the flare by clicking anywhere inside 
the image thumbnail or by dragging its cross hair.  

Lighting Effects Lets you produce myriad lighting effects on RGB images by varying 17 light styles, 3 light types, and 4 sets of light properties. You can also use 
textures from grayscale files (called bump maps) to produce 3D-like effects and save your own styles for use in other images.  

SHARPEN – used to focus blurry images by increasing the contrast of adjacent pixels. 

Sharpen and Sharpen More Focus a selection and improve its clarity. The Sharpen More filter applies a stronger sharpening effect than does the Sharpen filter. 

Sharpen Edges and Unsharp Mask Find the areas in the image where significant color changes occur and sharpen them. The Sharpen Edges filter sharpens only 
edges while preserving the overall smoothness of the image. Use this filter to sharpen edges without specifying an amount. For professional color-correction, use 
the Unsharp Mask filter to adjust the contrast of edge detail and produce a lighter and darker line on each side of the edge. This process will emphasize the edge 
and create the illusion of a sharper image. 

Smart Sharpen Sharpens an image by letting you set the sharpening algorithm or control the amount of sharpening that occurs in shadows and highlights. 

SKETCH – used to add texture to images, often for a 3D effect. The filters also are useful for creating a fine-arts or hand-drawn look. Many of the Sketch 
filters use the foreground and background color as they redraw the image. 

Bas Relief Transforms an image to appear carved in low relief and lit to accent the surface variations. Dark areas of the image take on the foreground color, light 
colors use the background color. 

Chalk & Charcoal Redraws an image's highlights and midtones with a solid midtone gray back-ground drawn in coarse chalk. Shadow areas are replaced with 
black diagonal charcoal lines. The charcoal is drawn in the foreground color, the chalk in background color. 

Charcoal Redraws an image to create a posterized, smudged effect. Major edges are boldly drawn, while midtones are sketched using a diagonal stroke. 
Charcoal is the foreground color, and the paper is the background color. 

Chrome Treats the image as if it were a polished chrome surface. Highlights are high points and shadows are low points in the reflecting surface. After applying 
the filter, use the Levels dialog box to add more contrast to the image. 

Conté Crayon Replicates the texture of dense dark and pure white Conté crayons on an image. The Conté Crayon filter uses the foreground color for dark areas 
and the background color for light areas. For a truer effect, change the foreground color to one of the common Conté Crayon colors (black, sepia, sanguine) 
before applying the filter. For a muted effect, change the background color to white with some foreground color added to it before applying the filter. 

Graphic Pen  Uses fine, linear ink strokes to capture the details in the original image and is especially striking with scanned images. The filter replaces color in the 
original image, using the foreground color for ink and background color for paper. 
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Halftone Pattern Simulates the effect of a halftone screen while maintaining the continuous range of tones.  

Note Paper Creates an image that appears to be constructed of handmade paper. The filter simplifies an image and combines the effects of the Stylize > Emboss 
and Texture > Grain filters. Dark areas of the image appear as holes in the top layer of paper, revealing the background color. 

Photocopy Simulates the effect of photocopying an image. Large areas of darkness tend to copy only around their edges, and midtones fall away to either solid 
black or white. 

Plaster Molds an image from 3D plaster, and then colorizes the result using the foreground and background color. Dark areas are raised, light areas are sunken 
(or reverse the effect by choosing the Invert option). 

Reticulation Simulates the controlled shrinking and distorting of film emulsion to create an image that appears clumped in the shadow areas and lightly grained in 
the highlights. 

Stamp Is best used with black-and-white images. The filter simplifies the image to appear stamped with a rubber or wood stamp. 

Torn Edges Is particularly useful for images consisting of text or high-contrast objects. The filter reconstructs the image as ragged, torn pieces of paper, and then 
colorizes the image using the foreground and background colors. 

Water Paper Uses blotchy daubs that appear painted onto fibrous, damp paper, causing the colors to flow and blend. 

STYLIZE – used to produce a painted or impressionistic effect on a selection by displacing pixels and by finding and heightening contrast in an image. After 
using filters like Find Edges and Trace Contour that highlight edges, you can apply the Invert command to outline the edges of a color image with colored lines or 
to outline the edges of a grayscale image with white lines. 

Diffuse Shuffles pixels in a selection to make the selection look less focused according to the selected option: Normal moves pixels randomly, ignoring color 
values; Darken Only replaces light pixels with darker pixels; and Lighten Only replaces dark pixels with lighter pixels. Anisotropic shuffles pixels in the direction of 
the least change in color. 

Emboss Makes a selection appear raised or stamped by converting its fill color to gray and tracing the edges with the original fill color. Options include an 
embossing angle (from -360° to lower (stamp) the surface, to +360° to raise the surface), height, and a percentage (1% to 500%) for the amount of color within 
the selection. To retain color and detail when embossing, use the Fade command after applying the Emboss filter. 

Extrude Gives a 3D texture to a selection or layer. 

Find Edges Identifies the areas of the image with significant transitions and emphasizes the edges. Like the Trace Counter filter, Find Edges outlines the edges of 
an image with dark lines against a white background and is useful for creating a border around an image. 

Glowing Edges Identifies the edges of color and adds a neon-like glow to them. This filter can be applied cumulatively with other filters using the Filter Gallery. 

Solarize Blends a negative and a positive image—similar to exposing a photographic print briefly to light during development. 

Tiles Breaks up an image into a series of tiles, off-setting the selection from its original position. You can choose one of the following to fill the area between the 
tiles: the background color, the foreground color, a reverse version of the image, or an unaltered version of the image, which puts the tiles version on top of the 
original and reveals part of the original image underneath the tiled edges. 

Trace Contour Find the transitions of major brightness areas and thinly outlines them for each color channel, for an effect similar to the lines in a contour map. 

Wind Creates tiny horizontal lines in the image to simulate a wind effect. Methods include Wind; Blast, for a more dramatic wind effect; and Stagger, which offsets 
the wind lines in the image. 

TEXTURE – used to give an image the appearance of depth or substance, or to add an organic look. 

Craquelure Paints an image onto a high-relief plaster surface, producing a fine network of cracks that follow the contours of the image. Use this filter to create an 
embossing effect with images that contain a broad range of color or grayscale values. 
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Grain Adds texture to an image by simulating different kinds of grain--regular, soft, sprinkles, clumped, contrasty, enlarged, stippled, horizontal, vertical, and 
speckle. 

Mosaic Tiles Draws the image as if it were made up of small chips or tiles and adds grout between the tiles. (In contrast, the Pixelate > Mosaic filter breaks up an 
image into blocks of different colored pixels.) 

Patchwork Breaks up an image into squares filled with the predominant color in that area of the image. The filter randomly reduces or increases the tile depth to 
replicate the highlights and shadows. 

Stained Glass Repaints an image as single-colored adjacent cells outlined in the foreground color.  

Texturizer Applies a texture you select or create to an image. 

VIDEO – contains the De-Interlace and NTSC Colors filters. 

De-Interlace Smooths moving images captured on video by removing either the odd or even interlaced lines in a video image. You can choose to replace the 
discarded lines by duplication or interpolation. 

NTSC Colors Restricts the gamut of colors to those acceptable for television reproduction to prevent oversaturated colors from bleeding across television scan 
lines. 

OTHER – these let you create your own filters, use filters to modify masks, offset a selection within an image, and make quick color adjustments. 

Custom Lets you design your own filter effect. With the Custom filter, you can change the brightness values of each pixel in the image according to a predefined 
mathematical operation known as convolution. Each pixel is reassigned a value based on the values of surrounding pixels. This operation is similar to the Add and 
Subtract calculations for channels. You can save the custom filters you create and use them with other Photoshop images.  

High Pass Retains edge details in the specified radius where sharp color transitions occur and suppresses the rest of the image. (A radius of 0.1 pixel keeps only 
edge pixels.) The filter removes low-frequency detail in an image and has an effect opposite to that of the Gaussian Blur filter.  

It is helpful to apply the High Pass filter to a continuous-tone image before using the Threshold command or converting the image to Bitmap mode. The filter is 
useful for extracting line art and large black-and-white areas from scanned images. 

Minimum and Maximum Are useful for modifying masks. The Minimum filter has the effect of applying a spread--spreading out black areas and shrinking white 
areas. The Maximum filter has the effect of applying a choke--spreading out white areas and choking in black areas. As does the Median filter, the Maximum and 
Minimum filters look at individual pixels in a selection. Within a specified radius, the Maximum and Minimum filters replace the current pixel's brightness value with 
the greatest or least brightness value of the surrounding pixels. 

Offset Moves a selection a specified horizontal or vertical amount, leaving an empty space at the selection's original location. You can fill the empty area with the 
current background color, with another part of the image, or with your choice of fill if the selection is near the edge of an image. 

 


